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General map notes: 
 

• A Splash Screen appears each time the results map opens, with a link to this user guide. 

• In some instances, more than one sample was collected in the area and assigned to the same unique eDNA_ID. This online map will 

only show one of those results. If you are interested in more results, please download the entire File Geodatabase from the website. 

• These procedures predominately show the western U.S. results map, but can be used for the eastern U.S. results map. 
 

 
 General map notes:  

• A Splash Screen appears each time the results map opens, with a link to this user guide.  

• In some instances, more than one sample was collected in the area and assigned to the same unique eDNA_ID. This online map will 
only show one of those results. If you are interested in more results, please download the entire File Geodatabase from the website.  

• These procedures predominately show the western U.S. results map, but can be used for the eastern U.S. results map.  
 

Overview 
 

There are tabs available along the left under the map name and tools available in the upper left-hand corner of the map under 

the search bar.     Navigating the Map 
 

Layer List | Legend Panel |Information |Change Base Map |Add Data Layer from ArcGIS Online, a URL, or a File 
 

Filter Points | Select Points by circle, rectangle, or polygon| Geoprocessing - Extract Points by Area of Interest | Search Bar 

 
The Attribute Table is available by selecting the arrow at the bottom of the map. Occasionally, AGOL will not show the table. 

You can access it by opening the table from the Layer List Panel. 

 

You can filter by attributes using the table. Note that the Filter Points button also allows you to create custom filters for 

species layers.  
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https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/the-edna-atlas-results.html
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=b496812d1a8847038687ff1328c481fa
http://www.fs.fed.us/rmrs/people/sparkes


2 

 

 
 

Navigating the Map – general tips 

To zoom in and out, use the + or – buttons in the upper-left hand corner of the map  or use the scroll on your mouse. 

To immediately zoom out to the initial extent, click the “home” button in the upper-left hand corner of the map  

 

To see the attributes of specific points on the map, use your mouse to click that point. A box will pop up with those available 

attributes. If more than one point is selected, you can use the navigation to see the next attribute. 

 

eDNAtlas sites sampled (sampled, results being processed) at the bottom of the map will be different from the pop-ups for 

individual species. That layer offers more fields in the pop-up and includes data from all species. 
 

 

 

 
 

Layer List   (ESRI help document for this tool) 

 

The Layer List tab loads with the map as the default first tab. To minimize this (or any) tab, click the arrow in the bottom right 

section of the tab. Users can see the current Operational Layers (Table of Contents) and turn those layers on and off and work 

individually with those layers. 

 

There are layers for all species that have been or are being processed. Some species currently do not have results and those 

layers will not have points until the database is updated with those results. 

The “Control All Layers” button in the upper-right corner of the Layer List tab controls the behavior of all of the layers 

in the list. Click the icon to open the menu that allows you to turn on or off all the layers, or expand or collapse all the layers. 

Navigate to the next 

point or line attribute 

 

 
View in Attribute Table 

Close the attribute 

window 

Zoom in to the 

selected point 

FIELD 4-character species  
2 = sampled, absent  

3 = sampled, present  

 

ONLY IN EDNATLAS SITES SAMPLED 
4 = sampled, being processed  

 

 

Species of the sampled 

point and its 

GNIS_NAME field of 

the underlying NHD v2 

stream layer. 

 

https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-layer-list.htm
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E5BHA
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Alternatively, you can use keyboard shortcuts to do so. Press Ctrl and click the check box of the layer to turn on or off the 

layers in the same level. Press Ctrl and click the arrow to expand or collapse layers in the same level. 

 
 

Use Ellipses (...) on the right side of the group or specific species layer to display the layer menu. 

 

• Zoom To—Sets the map extent to the extent of the layer. 

• Transparency—Sets the transparency for the layer.  

• Move up/down—Moves the layer one level up or down for this viewing session.  

• Enable Pop-up / Remove Pop-up—Enables or disables the pop-up for the feature layer.  

• View in Attribute Table—Opens the attribute table for the feature layer. 

• Show item details—Opens the service description or the item details page for the service or the item associated with 
the layer, if available. 

Legend Tab   (ESRI help document for this tool) 
 

The Legend panel shows the visible map layers and their symbols. Please note that the map initially only has the 1) Bull Trout 

Samples (green triangles and blue circles) and 2) eDNAtlas sites sampled (black squares) turned on. These black squares 

represent all submitted samples, including those with results and those samples that are still being processed. 

 

Any other layers you have chosen in the Layer List will also be available here. If you would like to add your own layers to the 

map, use the Add Layer tool. 

 

http://doc.arcgis.com/en/arcgis-online/get-started/view-legend.htm


4 

 

 
 

 

Information about the eDNAtlas Project   
The Information panel contains links to the project website, field sampling grid map, other documents, and includes the 

citation for this database. 

 

 

 

Basemap Gallery    (ESRI help document for this tool) 
 

Activating the Basemap Gallery panel allows you to choose a different basemap or background layer. This may be helpful as 

you zoom into your specific area of interest. 

 
Please note the sample points may not line up with the chosen basemap. The points are aligned with the NHD Plus version 2 NHDFlowline 

streams.  

Add Data Layer from a URL or ArcGIS Online   

 
Choosing the Add Data Layer button allows you to add other online layers to this map. You can 1) search the available data in 

ArcGIS online, or 2) enter a specific URL if you already have a web service link or a KML file, GeoRSS File or CSV file URL, 

or 3) upload a file from your computer. It supports shapefiles in Zip format, and CSV, GPX and GeoJSON files.  

 

Click arrows to 

minimize the 

Legend or any tab 

 

http://doc.arcgis.com/en/arcgis-online/create-maps/choose-scene-basemap.htm
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Click the icon to only search layers 
within the map area. Clicking it turns the 
icon red so you can search all layers in the 
scope.  

Click the sort icon to refine the type of 
search layer and sort the items.  

• Click the Type drop-down list to 
search layers based on map service, 
feature service, image service, vector 
tile service, KML, or WMS. 

• Click the Sort By drop-down list to 
sort items by relevance, title, owner, 
rating, view, or date. 

 

To add layers by URL, click the URL 
tab next to the Search tab. Choose a 
type and enter the URL. Click Add to 
add the data to the map. The added 
layer will appear in the Layer List 
widget as well. The following types are 
supported through the URL: 

• ArcGIS Server web service 
• WMS OGC web service 
• KML 
• GeoRSS 
• CSV 
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To remove layers added click LAYERS in the lower right corner of the Add Data window. In the Layers panel, click 
the trash can icon next to the layer to remove it. 
 
Click BACK in the lower right corner to return to the main Add Data panel. 

Note that you can’t remove the added layer without refreshing the map, but you can turn that layer off in the Layer List tab. 

 

Filter Points   
 

The Filter Points button allows you to filter the points on the map and in the attribute table by any attribute(s) you choose. 

The example below will create a filter for a specific species in a specific HUC 8 watershed. 

 

After clicking the filter button, click the “Create Custom Filter” button in the lower right-hand corner of the Filter window. 

Click the File tab to upload files locally. 
You can either drag and drop the file 
or browse to it. It supports shapefiles 
in Zip format, and CSV, KML, GPX 
and GeoJSON files. 
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Click the Layer drop-down and expand the National Genomics Center Lab Results by clicking the +. Once expanded, select 

the species layer you are interested in. 

 

 
Click the Add expression button. 

 

Use the dropdown to choose HUC8_Name (String) from the attribute list. The default is the OBJECTID. 

 

1 
2 

3 

Click here and 

drag to expand 

the box and make 

it bigger. 
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Leave the operator as the default “is”.  

 

Click the Settings gear and choose “Unique”. 

 

Use the dropdown box to select a HUC name or start typing part of the name to find a specific watershed. 

 
Note that only those watersheds that have sampled points for the chosen species will be available for selection. 
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Once you select a watershed, the map will zoom to that location. 

 

To turn off your filter, click the Apply button. Filters that are “on” are Green. Those that are “off” are Gray. 

 
 

 

 

 

If you would like to have 2 filters for a species, you can click the “Add set” button and following a similar procedure. For 

example, the filter below shows points within the North Fork Payette watershed with a MS_Hist greater than 1. 

 

For a list of attributes and their definitions, see the Field Names section at the end of this User Guide.  
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To view your filtered points in their attribute table, click on the ellipses (...) to the right of your species layer in the Layer List 

and choose “View in Attribute Table”. The attribute table will pop-up at the bottom of the map. 

 

 
You can use the Attribute Table to export points. 

 

 

 

 

Select Points (ESRI help document for this tool) 
 

Clicking this button and using the Select Points tool allows you to choose up to 1000 specific points on the map. The default 

is to select up to 1000 points in those layers turned on in the Layer List, but you can use the check boxes to turn on additional 

layers or turn off others after the Select window is open. 

 

This button allows you to select the points from the active layers on the map by a rectangle, or a circle, or a lasso/polygon. 

You can use it in conjunction with the Filter tool or you can zoom in and select points in a general area. You can view the 

selected points in the attribute table, and even export to a CSV file from there.  

 

Please note that this selection tool doesn’t allow export to a shapefile or geodatabase. It also does not allow for you to select 

more than one area. For those options, please see the Geoprocessing - Extract Points by Area of Interest button. 

 

 
Select by Rectangle and Select by Circle draw those shapes for you. Select by lasso requires that you draw your polygon 

boundary and you will need to click the map to start that polygon and drag to create the area. 

 

https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-select.htm#ESRI_SECTION1_037E2A1D92164041AA5158D86F287FAA
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You can clear your selection by clicking the “Clear” button in the upper right-hand corner of the Select window. If you have 

already closed the window, you can click the Select button again to open the window and clear the selection. 

 

After a moment, the points of each species or layer turned on in the Layer List tool are selected. Once they are available, click 

the ellipsis (…) to see your options.  

 
 

Clicking “View in Attribute Table” will open the species attribute table at the bottom of the map with those points selected. 

You can export from the table, or directly from the selection tool if more than 1 point is selected.  

Click here and 

drag to expand 

the box and make 

it bigger. 

Click in the upper-

right to universally 

change which layers 

are selectable. 
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Geoprocessing - Extract and Download Points by Area of Interest  
(ESRI help document for this tool)  
 

Clicking the Extract Points by Area of Interest button brings up a geoprocessing tool that allows you to select an area of 

interest in the map. Once you’ve made your selection, you can export the points within those area(s) of interest as a 

geodatabase or shapefile. If you would like to download the entire GeoDatabase you can do that here - 

https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/the-edna-atlas-results.html 

Notes: 

• You can create more than one polygon to select different areas. You can select a box around one stream and a 
polygon around another. 

• You can select using multiple area of interest types (freehand polygons, circles, rectangles, etc.) 

• This tool does not select points in the attribute table. Rather, it allows the points within your area(s) of 

interest to be exported to a shapefile or geodatabase. To select or filter points for use in the attribute table, 

see those tools. 

• An extracted Geodatabase will contain all points from the GeoDatabase within the selected area of interest, and not 

just those that have been filtered or queried.  

• An extracted Geodatabase will be in a zip file called “_ags_output.zip”. Inside the zipfolder in that zip file, the 

geodatabase is called eDNAtlas_West_AGOL_SampleGridAndResults.gdb (or 

eDNAtlas_East_AGOL_SampleGridAndResults.gdb) with a point feature class of the same name, as would a 

shapefile. Although, note that some field names will be truncated in the attribute table if you choose to download a 

shapefile. The geodatabase feature classes and shapefiles each include ArcGIS metadata. 
 

Once you’ve selected your area(s), click the “Run” button. Depending on the size of your browser window, you may need to 

scroll down to see the button. After a few moments, the Output tab will have a link to an output zip file containing a shapefile 

with your selected features. A File Geodatabase is recommended so the field names that are exported will not be truncated, as 

will occur with shapefile format. A gdb file will also keep null values instead of creating zeros. 

 

 

Scroll or expand 
the window for 
the Run button 
 

 

http://doc.arcgis.com/en/web-appbuilder/create-apps/widget-geoprocessing.htm#ESRI_SECTION1_F13A2550845D46CF812375675132DAD6
https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/the-edna-atlas-results.html
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Search Bar   
Search for a stream by NHD Plus version 2 GNIS_NAME. Type your search and hit ‘enter’, or click the magnifying glass. 

 

Searches take a moment and return up to 500 results. Once a name is selected, it will automatically zoom to that result, but the 

search bar will have a slider to search for other results. Click another result and the map will zoom or pan to that location. 
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Tip:  If you filter the available points to a specific HUC, the search results will be only those GNIS names within that specific 

HUC. 

Attribute Table   

 

The attribute tables can be opened and closed by clicking the arrow located at the bottom of the map. Originally, the only 

table available is the eDNAtlas sites sampled attribute table. This table contains a lot of points and may take a few moments to 

load. To add a species-specific table to the map, click on the ellipses (...) to the right of the desired species layer in the Layer 

List and choose “View in Attribute Table”. The attribute table will pop-up at the bottom of the map. 

 

 
 

 

You can click the Options button in the upper left-hand corner of the table to create a filter or to show different columns. As 

you zoom in on the map, the default is to filter the attribute table based on what is in the map extent. Click that option to turn 

it off. You can filter and select point(s) and then zoom to that location. 

 
If there are no points selected, there is an option to export all points in the attribute table to a CSV file. If points are selected, 

the option is to export only those points. You can use the filter and select tools together to narrow down and select points. Or 

you can select by simply clicking to the left of the point in the table.  

 

To select more than one point, use your shift key. Note that your mouse will change from an arrow to a pointing hand when 

selecting. 

 

Once you have selected all the points you wish to export, Click the Options tab in the upper left-hand corner of the table and 

choose the “Export Selected to CSV” option.  
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You will be prompted to confirm that you want to export to a CSV file. Click OK. 

 
You then have the option to Open or Save the file. Click OK. 

 
 

The csv file will include an X and Y coordinate added to the table by ArcGIS Online and in the original coordinate system 

(Albers, NAD 83). There is a 1000 record limit for downloading a CSV. If you would like more points, please download the 

entire geodatabase and use GIS. 

 

Please note that there is no automatic download of the metadata with the table as there is when you download using the 

Extract points by Area of Interest selection tool and export as a shapefile. You can find a general metadata document on the 

eDNAtlas website. 

 

To remove the filter, click the X to the right of the filter expression and click OK. 

 

 
 

 

Field names and descriptions 
Note that more detailed metadata can be found in the GeoDatabase itself or on the eDNAtlas website.   

 

FIELD eDNA_ID  ►  

https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/downloads/eDNAtlas-General-Metadata-for-GeoDatabase.pdf
https://www.fs.fed.us/rm/boise/AWAE/projects/the-aquatic-eDNAtlas-project.html
https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/the-edna-atlas-results.html
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E0VB0BHA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E0VB0BHA
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Primary key. A unique ID for each eDNA sample point. The ID takes the form AAAAAAAA-BBB-CC, where A is the 8-digit Watershed 

Boundary Dataset (WBD) hydrologic unit code (HUC), B is a unique number assigned to each stream reach in the HUC, and C is a unique point 

on the stream reach. If you collect samples in the field, this is the number that needs to be associated with that sample site location. 

FIELD HUC8  ►  

8 digit unique code for each HUC from the Watershed Boundary Dataset (WBD). 
FIELD HUC8_Name  ►  

HUC name from the WBD 

 

FIELD Site_ID  ►  

The unique site within each 8-digit HUC. The site ID takes the form BBB-CC, where B is a unique number assigned to each stream reach in the 
HUC, and C is a unique point on the stream reach. 

 

FIELD COMID  ►  

Common identifier of an NHDFlowline feature (COMID code from the NHDPlus V2 dataset) 
 

FIELD GNIS_NAME  ►  

Feature name from Geographic Names Information System (stream name from the NHDPlus V2 dataset) 
 

FIELD REACHCODE  ►  

Reach code assigned to feature (REACHCODE from the NHDPlus V2 dataset) 
 

FIELD TotDASqKM  ►  

Total upstream cumulative drainage area, in square kilometers, at the downstream end of the NHDFlowline feature. 
 

FIELD DD_X  ►  

Geographic coordinate X in decimal degrees 

 

FIELD DD_Y  ►  

Geographic coordinate Y in decimal degrees 
 

FIELD UTM_Zone  ►  

UTM Zone of the sample grid point 

 

FIELD UTM_X  ►  

UTM X coordinate of the sample grid point, unique by eDNA_ID 
 

FIELD UTM_Y  ►  

UTM Y coordinate of the sample grid point, unique by eDNA_ID 

 

FIELD FCODE  ►  

Numeric codes for various feature attributes in the NHD Plus version 2 FCODE lookup table. 
 

FIELD PublicLand  ►  

These data are from PAD-US, Protected Areas Database of the US. https://gapanalysis.usgs.gov/padus/  
 
Own_Name - Land owner or holding agency (e.g. USFS, State Fish and Game, City Land, TNC) standardized for the US. See PAD-US Data 
Standard or geodatabase look up table for "Agency Name" for full domain descriptions. Use "Manager Name" for the best depiction of federal 
lands as many overlapping designations (i.e. "Designation") and ownership related data gaps (i.e. "Unknown") occur in the federal theme.  

 

FIELD MS_Hist  ►  

Mean summer historical flow [Mean summer flow is the average of daily flow between June 1 and September 30; Units: cubic feet per second] 
from Variable Infiltration Capacity (VIC) flow model. 

 

FIELD eDNA_Slope  ►  

Stream gradient of the reach above the sample point up to the next sample point, stream confluence, or headwater initiation point. Units: 
percent. Generated internally using NHDPlusV2 National Elevation Dataset data. 

 

FIELD Elev_m  ►  

The underlying elevation data used is from the National Elevation Dataset (NED) at 30 m resolution. 
 

FIELD Date_Collected  ►  

The date a previously collected sample was collected in the field as noted by the contributor. Null indicates no previous sample taken and 
assigned to the unique eDNA_ID.  
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FIELD Field_UTM_Zone  ►  

UTM Zone of the collected sample as noted by the contributor. Null indicates either field coordinates are not in UTM or that no previous sample 

taken and assigned to the unique eDNA_ID. 

 
FIELD Field_UTM_Easting  ►  

Field X coordinate of the collected sample as noted by the contributor. Null indicates no previous sample taken and assigned to the unique 

eDNA_ID. 

 
FIELD Field_UTM_Northing  ►  

Field Y coordinate of the collected sample as noted by the contributor. Null indicates no previous sample taken and assigned to the unique 
eDNA_ID. 
 

FIELD Agency  ►  

Name of agency or group that collected the field sample.  
 

FIELD Species Code listed in the table below below  ►  

Note that the fields below are available in their respective layer in the layer list and that all fields are in the  “eDNAtlas sites sampled” layer. 

LIST OF VALUES   

VALUE 1  

DESCRIPTION not sampled  

 

VALUE 2  

DESCRIPTION sampled, absent  

 

VALUE 3  

DESCRIPTION sampled, present  

 

VALUE 4  

DESCRIPTION sampled, being processed  

Species Code 
Field Name 

Common Name Genus Species subspecies 

AEEL American eel Anguilla rostrata   

ANCA California floater Anodonta californiensis/nuttaliana   

ANOR Oregon floater Anodonta oregonensis/kennerlyi   

BOTO Western toad Anaxyrus boreas   

BRKT Brook trout salvelinus fontinalis   

BRNT Brown trout salmo trutta   

BULL Bull trout salvelinus confluentus   

BURB Burbot Lota lota   

CAVI Bluehead sucker (Snake/Bonneville) Catostomus virescens   

CCAT Channel catfish Ictalurus punctatus   

CHIN Chinook salmon Oncorhynchus tshawytscha   

CHUM chum salmon Oncorhynchus keta   

CMCP Common carp Cyprinus carpio   

COHO Coho salmon Oncorhynchus kisutch   

COTF Coastal Tailed Frog Ascaphus truei   

DOVN Dolly Varden salvelinus malma   

DRES Zebra/Quagga Mussel Dreissena spp.   

GRIZ Grizzly/Brown bear Ursus arctos   

GSUN Green sunfish Lepomis cyanellus   

file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0CB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0CB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0BB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0BB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0AB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arc7B0A/tmp6E9F.tmp.htm%23ID0E0AB0ADA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E6BHA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E6BHA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E6BHA
file:///C:/Users/sparkes/AppData/Local/Temp/1/arcA268/tmpDAF5.tmp.htm%23ID0E6BHA
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LAKT Lake trout salvelinus namaycush   

LAMP Lampetra spp. Lampetra     

LHCT Lahontan cutthroat trout Oncorhynchus clarkii henshawi 

LISY Wood Frog 
Lithobates 
[Rana] sylvaticus   

LOMW Loach minnow Rhinichthys  cobitis   

MTSU Mountain sucker Catostomus jordani   

MYSS Opposum shrimp Mysis diluviana   

NOLS Northern leatherside chub Lepidomeda copei   

NOPI Northern pike Esox lucius   

NZMS New Zealand mudsnail Potamopyrgus  antipodarum   

OMMW Olympic mudminnow Novumbra hubbsi   

PALA Pacific lamprey Entosphenus  tridentatus   

RGCH Rio Grande chub Gila pandora   

RGSU Rio Grande sucker Catostomus plebeius   

RHVA Southern torrent salamander Rhyacotriton variegatus   

RMSC Rocky Mountain sculpin Cottus  sp.   

RMTF Rocky Mountain tailed frog Ascaphus montanus   

RNBT 
Rainbow trout/Steelhead/Redband 
trout Oncorhynchus mykiss   

RTCH Roundtail chub Gila robusta   

RVOT North American river otter Lontra canadensis   

SAGR Sauger Sander canadensis   

SAPI Sacramento pikeminnow Ptychocheilus grandis   

SCUL Any sculpin Cottus  spp.   

SLMD Any salmonid       

SLSC Slimy sculpin Cottus  cognatus   

SMBA Smallmouth bass Micropterus dolomieu   

SNAP Snapping turtle Chelydra serpentina   

SPKD Spikedace Meda fulgida   

STGC Sturgeon chub Macrhybopsis  gelida   

UMQC Umpqua chub Oregonichthys  kalawaseti   

WALL Walleye Sander vitreus   

WEPS Western pearlshell Margaritifera falcata   

WPTL Western Pond Turtle Actinemys marmorata   

WRMS Western ridged mussel Gonidea angulata   

WSCT Westslope cutthroat trout Oncorhynchus clarkii lewisi 

WSFT Western spadefoot toad Spea hammondii   

YSCT Yellowstone cutthroat trout Oncorhynchus clarkii bouvieri 

 

Filter Attribute Table by Stream Name example   

 

Click on the arrow at the bottom of the map to open the attribute table. Note that the default is to only show those points that 

are within the current map extent. Unselect that option if you would like to filter all points.  
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Click the Options tab in the upper left-hand corner of the table and choose the Filter option. 

 
 

In the Filter window, click “Add expression” and then use the field dropdown to choose GNIS_Name (String). Click the 

settings  button and choose the Unique option to allow a drop-down of all unique values in the attribute table for that 

field.  

 

 
After a moment, click the dropdown. It will be populated with the available GNIS stream names. Choose your desired Stream 

and click “OK”. 

Both the map and the attribute table will show only the points with that GNIS name. You can click to the left of the first 

record in the table, move the slider bar along the right all the way to the bottom of the filtered attributes, and then click the 

shift key and select the last record. This will select all the points you have filtered. 
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Note that your mouse will change from an arrow to a pointing hand when selecting. 

 

Once you have selected all the points you wish to export, Click the Options tab in the upper left-hand corner of the table and 

choose the Export Selected to CSV option. 

 
 

You will be prompted to confirm that you want to export to a CSV file. Click OK. 

 

You then have the option to Open or Save the file. Click OK. 

 
Please note that there is no automatic download of the metadata with the table as there is when you download using the 

Extract Points by Area of Interest tool and export as a shapefile. You can find a general metadata document on the eDNAtlas 

website. 

 

To remove the filter, click the X to the right of the filter expression. 

https://www.fs.fed.us/rm/boise/AWAE/projects/eDNAtlas/downloads/eDNAtlas-General-Metadata-for-GeoDatabase.pdf
https://www.fs.fed.us/rm/boise/AWAE/projects/the-aquatic-eDNAtlas-project.html
https://www.fs.fed.us/rm/boise/AWAE/projects/the-aquatic-eDNAtlas-project.html
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If you have more questions about using the filter tool, see the ESRI help document for this tool. 

 

Please cite downloaded data as: 

Young, Michael K.; Isaak, Daniel J.; Schwartz, Michael K.; McKelvey, Kevin S.; Nagel, David E.; Franklin, Thomas W.; 
Greaves, Samuel E.; Dysthe, J. Caleb; Pilgrim, Kristine L.; Chandler, Gwynne L.; Wollrab, Sherry P.; Carim, Kellie J.; Wilcox, 
Taylor M.; Parkes-Payne, Sharon L.; Horan, Dona L. 2018. Species occurrence data from the aquatic eDNAtlas database. Fort 
Collins, CO: Forest Service Research Data Archive. Updated 31 July 2020. https://doi.org/10.2737/RDS-2018-0010.  

 

eDNAtlas interactive maps -  

Link to eDNAtlas western Sampling Grid ArcGIS Online Map 

Link to the eDNAtlas eastern Sampling Grid ArcGIS Online Map 

Link to the eDNAtlas Results ArcGIS Online Map for the western US 

 

Link to the eDNAtlas Results ArcGIS Online Map for the eastern US 

 

For use with ArcGIS Online –  

Western results https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_01/MapServer  

Western grid 

https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_SiteLocations_01/MapServer 

Eastern results https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_East/MapServer    

Eastern grid 

https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_East_SiteLocations_01/MapServer 

 

 

 

 

Questions about this User Guide, or need trouble-shooting ideas? Please contact Sharon (Parkes) Payne 

http://doc.arcgis.com/en/web-appbuilder/create-apps/widget-filter.htm
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=f2e1cd032dbc43709dfa6d7013ca3fc8
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=5ed6fe1f7833491ebc3f62b44eece224
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=b496812d1a8847038687ff1328c481fa
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=62aadbb170744ff881fb742ddedecfbc
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_01/MapServer
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_SiteLocations_01/MapServer
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_East/MapServer
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_Aquatic_eDNAtlas_East_SiteLocations_01/MapServer
http://www.fs.fed.us/rmrs/people/sparkes
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